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SIMS can hold a varying array of data, ranging from student attendance, assessment, behaviour, achievement to staff absence and cover. Being able to extract this raw data to represent it in a more meaningful and tangible way is more of a need now than ever. Unless an individual is skilled in Excel formulas, pivot tables, macros, etc, it can be quite challenging to represent this data visually. SIMS Discover is still a great analysis tool, however it has its limitations on what can be analysed or represented visually. Microsoft’s Business Intelligence software solution called Power BI allows you to create powerful, interactive dashboards and visualisations with relative ease.

What is Microsoft Power BI and why is it gaining recognition?
Power BI is allows you grasp a full overview of your data in a meaningful and interactive way, allowing you to represent data via dynamic, interactive visualisations and dashboards. With a few simple clicks, it allows you to get the right insights to drive intervention, strategic decision making, etc.
The Power BI Desktop app allows you to import your SIMS data as a data source (for example an Excel spreadsheet or .txt file). If you have imported two or more tables, you can also manage relationships between the tables (e.g. one-to-one, one-to-many, etc). You can then create reports, add filters and choose from a range of visualisations (and import hundreds more). You can save your reports as Power BI files (with an extension of .pbix) and publish the interactive reports online for sharing.
This document will assist you in getting started from initially downloading the Power BI app to creating a fully interactive working dashboard using SIMS data as its source.


Is there a cost for using MS Power BI or is it free?
Power BI Desktop is free and any single user and includes data cleansing and preparation, custom visualisations and the ability to publish to the Power BI service.
However, MS Power BI Pro costs $9/99/£7.63 per month.*
If you currently already have an Office 365 license, you will be entitled to use MS Power BI Pro with no additional charge.

The screenshot below from Microsoft highlights the differences between MS Power BI Free and MS Power BI Pro:




[image: ]

* This value is subject to change and based solely on Microsoft corporation business strategy

Where can I download the Power BI Desktop app from?
You can download the installation file for MS PBI via the following hyperlink:
https://powerbi.microsoft.com/en/downloads
[image: ][image: ]
Once it’s downloaded, run the installation file and follow the instructions to install the software. If you don’t have the administrative privileges to install software, you may need to speak to your IT support team to ensure that it’s installed properly.
You should have an icon in your start menu in Windows like the one showing opposite.


Creating and Logging into your Power BI account?
Once you’ve successfully downloaded and installed the Power BI app, when you run it for the first time, you will be prompted with a landing prompt screen similar to the one below:
[image: ]
Click the link that says ‘Already have a Power BI account? Sign In’, even if you don’t have one set up initially.





If you already have a Power BI account, you can simple log in with your email and password. If however you need to create a new account, simply click the link below saying ‘Need a Power BI account? Try for free’.
 













You will be then prompted to enter a valid work email address:
[image: ]

If you enter a non-valid email address, you will be given the following error message:
[image: ]


Also, if you try to enter in a personal email address, again you will be prompted with an error message:
[image: ]

Ensure you enter in a valid work email address as in the example below and then click the Sign up  button:
[image: ]


Once you’ve entered in a valid work email address, you will receive a verification code via email as shown in the example below:
[image: ]










You will then be prompted to enter in your Forename, Surname and a valid password (at least 8 characters including an UPPERCASE, lowercase, numerical and special character. You will also need to enter in the 6 digit code sent to you by email from Microsoft.
[image: ]
At this stage, you could either invite other users to Power BI or just Skip the process by clicking the Skip button:
[image: ]

You will then be able to manage your Office 365 settings online:
[image: ]

Back in Power BI at the Sign In prompt, enter your work email address that you registered with and click the Sign In button:
[image: ][image: ]

Then enter in your chosen password










You’ll then notice that it will have your name on the right hand side when you’re logged into Power BI. For example: 
[image: ]



























Creating the SIMS Report for Power BI Dashboard
We will create a student report pulling through some typical contextual data along with attendance data within a date range and then export that data in a text format.
In SIMS, go to Reports | Design Report | Create a new report
[image: ]

[image: ]
Ensure it’s Student report, then click Next.

[image: ]



Choose Status of student as On Roll.
[image: ]
Add the following student data fields, ensuring you change the corresponding Captions if required (as indicated by the square brackets).

[image: ]

Once you’ve added the normal student data fields, you will then need to add a sub report for Attendance marks (indicated by the blue icon). We will work on one first, finalise it, clone it, then tweak the cloned one as necessary.
[image: ]


Ensure you click the red book icon (on the right hand side) when selecting the sub-report to allow the filtering of data within the sub-report.

[image: ]

In order to determine the total number of possible attendance session marks within a date range, select the Statistical meaning field and choose Condition as being ‘is one of’ and select all the field (Select All button), then deselect the ‘Attendance not required’ button.
Ensure that the ‘Prompt at runtime’ button isn’t selected.

[image: ]
[image: ]
Once the first condition has been specified. click the ‘And’ button, allowing a second condition to be created.
[image: ]
This time, for the second condition, select Mark date. Choose the between condition and select a Start and End date, ensuring you tick the ‘Prompt at runtime’ checkbox.

[image: ]
Once, the first sub-report has been completed with both filters, it is easier and quicker just to click the Clone button on the right hand side and then to make any necessary tweaks on the new sub-report.

[image: ]
Once you’ve clicked the clone button, just change the Caption to indicate Actual marks and modify the Statistical meaning filter to select Present and Approved Educational Activity boxes only.
[image: ] (cloned sub report)
[image: ]
Then Click OK.
Power BI can accept a range of data types as sources, for example Excel files, CSV, XML, Doc, HTML, Txt, etc. For the report just created, select Select the Default Output hyperlink. It will originally default to Word List Report.

[image: ]

Ensure you select Text as the Output type. You’ll notice that it will indicate ‘Text’ on the Output type.
You will then need to specify a location on the network where the generated text file will be exported to. 
For example:
K:\SIMS\Power BI\Data Source for Dashboards\Pupil_Data.txt
This will then generate a text file named Pupil_Data.txt


[image: ]

If you can’t see the file extensions in Windows (unhidden by default), you can unhide them by opening any folder then going through the following routine (in Windows):
File | Options | View | Untick ‘Hide extensions for known file types’

[image: ]

You can save the report by  selecting Save, Save As… [image: ] 
Give the report a suitable name, such as the example below. (You can either make the report Private (only you can see/run it) or untick the Private button, meaning other members of staff can also see/run the report). Once you’ve gave it a name, click the Save button again to save the report in the reports library.
[image: ]
Then when you click the run button, it will generate the named file in the selected output folder:
[image: ]
Just to confirm that the data has been exported successfully, you can open the file to view the data:
[image: ]

Opening Power BI Desktop and locating Source Data
If you have Power BI Desktop already installed on your machine, simply click the yellow icon to load the software.
[image: ]
Power BI Desktop will load up. It will take slightly longer to load up compared to Microsoft Office programs and will also depend on the speed/power of your machine. 
[image: ]
Once it’s loaded, you will be prompted to log in. Simply click the Sign In button and you will be prompted to enter in your business email address.
[image: ]

Once you’ve entered your email address, click the Sign In button.
[image: ]









Then enter in your password. 

[image: ]
To get the source data (i.e. the text file we generated earlier), on the Home tab, click the drop down button on the ‘Get Data’ menu and select ‘Text/CSV’
[image: ]

Then navigate to the folder where the text file is located and select the Open button.
[image: ]
You will receive a message indicating that the data is being processed.
[image: ]
Once the data has been processed, it will be displayed in a table format like the one below:
[image: ]
Then click the Load button to pull the data into Power BI Desktop.

[image: ]
It will indicate that the data is being loaded onto the mode.
[image: ]

Once it’s been successfully loaded, you will initially see the blank ‘canvas’ on the Report section
[image: ]
[image: ]
The next tab (Data) will show the raw data in tabular format.
[image: ]
[image: ]









The last tab (Model) will show the table in a ‘relationships’ view, thus allowing you to link multiple tables using unique identifiers (keys) such us UPNs, Admission Numbers, etc.
[image: ]

[image: ]
















Creating Columns and Saving the Template
So in order to calculate the attendance based on a specified date range (at run time), it is necessary to define a calculation or more commonly known as a Data Analysis Expression (DAX). The formula is a percentage calculation of Actual Marks divided by possible marks.
So in order to calculate and store these values per child record, the first thing we need to do it add a new column. On the Home tab (horizontally) and on the Data tab (vertically), in the Calculations section, select New Column.
[image: ]

A new column will be generated on the right hand side, and will be defaulted to the name ‘Column’. 
[image: ]

In the DAX window (white section where you can type in the formula), type in the following statement:
Percentage Attendance = IF(PowerBI_Data_Primary[Actual Marks]=0,0,(PowerBI_Data_Primary[Actual Marks]/PowerBI_Data_Primary[Possible Marks])*100)

You will notice that as you type the word ‘Actual’, the Actual Marks column field appears. Simply select the field and press the Tab button to include the field in the formula. Repeat also for the Possible Marks.
[image: ]

Once the formula (DAX) is completed, you will then have a new column with the Attendance percentages calculated.
[image: ]


You may notice however that the attendance calculated defaults to 13 decimal places!
[image: ]
In order to change that to 2 decimal places, select the Modelling tab, and select 2 in the Format Decimal Number section. You’ll then notice the numbers in the Percentage Attendance column narrow down to 2 decimal places.
[image: ]
[image: ]
You’ll notice that ‘Percentage Attendance’ now appears on the rights hand side along with the originally imported data fields.
[image: ]
We will then need to do the same with for the Persistence Absence (PA) calculation.
Similarly, click the new column and type in the following DAX:
PA = IF(Pupil_Data[Percentage Attendance]<90,"Y","N")
[image: ]

Those with an overall percentage less than 90% will have a ‘Y’ in the PA column[image: ]
You’ll notice on the right hand side there are now the 2 new data fields we’ve manually added via DAX / calculations.
[image: ]
Next, you would need to save the report as a new file via File | Save As.
  [image: ]

Give it a suitable name (for example Primary – Dashboard) and then click the Save button.
[image: ]


In order to calculate the attendance figures for a cohort of pupils, for instance Y3 pupils or Pupil Premium pupils, a new calculation or DAX would need to be created. However, this will be in the form of a New Measure:

[image: ]
Click the New Measure button and then enter in the following DAX:
Cohort_Attendance = (SUM(PowerBI_Data_Primary[Actual Marks])/SUM(PowerBI_Data_Primary[Possible Marks]))*100






















Creating Visualisations
We will go through creating 6 different types of visualisations along with filters that will use the source data from the SIMS report. Below is an example of our completed dashboard:
[image: ]
The 6 types of visualisations are as follows:
· Stacked column chart –Student number totals by year group
· Gauge – Percentage Attendance
· 100% Percent Stacked Column Chart – Persistent Absence numbers
· Treemap – Ethnicity breakdown by numbers/sizes
· Pie Chart – SEN: Not-SEN, K and E
· Table – Student Name and Reg group
















Stacked column chart –Student number totals by year group
Click the Stacked column chart in the visualisations selection panel on the right hand side.
[image: ]

A blank chart will appear on the report area (canvass).

[image: ]







It is possible to move any visualisation anywhere around the canvass by dragging and dropping from any part of the visualisation area
[image: ]

In the Values axis, drag and drop the Year data field

[image: ]


You’ll notice that it will say Year in the top right hand side of the chart
[image: ]

[image: ] 



Pull the Student data icon into the Value field











[image: ]


The chart will now reflect the number of students in each year. However, it doesn’t by default show the actual numbers in each year.







In order to show the data labels (i.e. numbers in each year) first of all click the Format Tab
[image: ]

Then ensure you click the On switch on the Data labels section as shown below:
[image: ]

You’ll notice now that the numbers in each year appear on top of each data bar.
[image: ]



Gauge – Percentage Attendance
Click the Gauge icon in the Visualisations section and a blank gauge will appear on the canvass.
[image: ]

[image: ]

[image: ]
Grab the Cohort_Attendance field we created earlier and place it on the Value field show opposite: 




You can see now how the attendance figure changes to an average value. However, the range in the example below defaults to 0 to 181.90 whereby in fact it should be from 0 to 100 (ideally indicating the PA threshold also). The next image will indicate how this is achieved.
[image: ]



[image: ]


Click the format tab (paint roller icon) and select the Gauge axis dropdown. Here you can specify the Minimum, Maximum and Target values. Enter 0 for Minimum, 100 for Maximum and 90 for Target (i.e. to have attendance figures above this threshold).













You can see now below how the range has been modified from 0 to 100, also indicating a target value, highlighted by the black line and specified value of 90.


[image: ]

It is also possible to rename the heading of the visualisation. Click the Fields tab again, press the drop down for the value and select rename.

[image: ]

For example, rename it to Attendance.
[image: ]

You can see now how the Visualisation header is altered accordingly.
[image: ]


























100% Percent Stacked Column Chart – Persistent Absence numbers
Click the 100% Stacked Column Chart icon in the Visualisations section and a blank chart will appear on the canvass. 

NB: By the way, if you ever select any previously created visualisation and then those another visualisation whilst the previous one is selected, the new visualisation selection with over-ride the previous one. This can easily be reverted if required by simply re-selecting the original visualisation. So just to bear in mind, to add a new visualisation, always ensure you have selected the blank canvass and make sure no previously created visualisations have been selected.

[image: ]

Selected the Year field and drag and drop onto the Axis field.
[image: ]



Drag and drop the PA field we created earlier onto both the Legend and Value fields as shown below:
[image: ]

For extra emphasis, it is also possible to change the default colour for PA (Y) so they stand out more, for example red. Select the Format tab and they select ‘Data colors’.
[image: ]





You can then choose a different colour. By pressing custom colour, you can literally select any colour you wish.

[image: ]

For added emphasis, select a red colour as a sign/colour of warning.
[image: ]















You can see how the colours stand out.
[image: ]

You can also show the values in each section by clicking the On button in the Data labels section on the Format tab.
[image: ]















Treemap – Ethnicity breakdown by numbers/sizes

The Treemap icon will produce a blank Treemap on the canvas. 
[image: ]

Select Ethnicity, drag and drop onto the Group field
[image: ]

Select the Student field and drag and drop onto the Values field
[image: ]

The Treemap will be populated accordingly. If you resize the visualisation in any way, smaller or larger, each segment will re-size itself, representing a percentage equivalent in space relative to the overall dimensions of the oblong.
To resize, simply drag one of the corner edges of the treemap and either expand or contract in size to see the visualisation morph and resize its segments and overall whole in real time.

[image: ]

To see the actual numbers of students in each segment, simply set the Data labels to On on the Format tab.
[image: ]

You can see how each of the segments are comprised of students (as numerical values)





[image: ]

Pie Chart – SEN: Not-SEN, K and E
The Pie Chart Icon will produce a blank pie chart on the canvas. 
[image: ]

Drag and drop the SEN field onto the Legend field.
[image: ]






[image: ]



Then drag and drop the Student field onto the Values field.









On the Format tab, switch the Legend button On.
[image: ]

[image: ]


The Pie chart will then show the legend.
As previously mentioned, the headings can be renamed and colours can be modified if required.











Table – Student Name and Reg group
The table icon in the visualisations section will produce a blank table initially.
[image: ]

With the table highlighted drag and drop the Student field onto the Values field.
[image: ]

The table will become populated immediately.









Filters
Power BI is designed for interactive use and dynamic analysis.
So for instance, to see the overall attendance for Non-SEN, you could simply select the Non-SEN segment in the pie chart and all the visualisations in the dashboard will alter immediately based on that selection. You can see from the example below that Non-SEN attendance is lower that the school average
[image: ]

Also by clicking the SEN – K section of the pie chart will show the attendance figures for that cohort immediately. We can see below that the SEN – K pupils have a higher than average school attendance figure 

[image: ]



In order to clear any dashboard level filters simply click the filtered field again to revert back to showing all the data.

[image: ]

You can add dashboard level filters by simply dragging the required fields onto the canvas. These default to table format but can be changed 
For example, select the following filters:
· PP
· Gender
· FSM
· EAL
When you first drag a filter onto the dashboard, it may initially look too wide, so you may want to re-size it for better functionality and navigation for the end-users.
[image: ]




Once you’ve re-sized it, you can then do the same for Gender, FSM and EAL.
[image: ]

So now, by clicking any button as a filters, the visualisations will alter accordingly.
There are however limitations if you choose to filter this way as it’s a basic way of filtering, i.e. 1 condition at a time.
If for instance you wanted multiple filters, for example PP=Yes, Gender=Male, FSM=Yes, EAL=No, then you would have to set the filters slightly differently.
You could select any of the filters you’ve just added, for example PP, then click the Slicer button in the visualisations panel.
[image: ]


As you can see below, this has now converted the original filter to a checkbox type filter, potentially allowing multiple filters at once. However, initially by default, you can only choose one at a time. In order to allow you to select multiple criteria, select the Format button, in the Selection controls area, turn off the Single select option.
[image: ]











[image: ]

Repeat the procedure for Gender, FSM and EAL 
[image: ]
You can now see how selecting multiple filter criteria updates all the visualisations on the desktop dynamically:
[image: ]

It it also possible to have your filters represents as a dropdown list, as opposed to a series of checkboxes.
Hover over the top right PP filter (over the dropdown arrow) and you will get the following popup:

[image: ]

If you click the down arrow, you will then be able to select Dropdown as an option
[image: ]

This will then alter how you can access your filters. 
[image: ]
When you press the down arrow, you will see all the available options in the filter
[image: ]
If you have selected multiple choices, it will highlight on the dropdown.
[image: ]


Publishing the dashboard
Click the Publish button to start the upload wizard allowing you to view your report and dashboard in Power BI (online portal).
[image: ]

You may be prompted to save the report. Click the Save button if necessary.
[image: ]

Select My workspace to Publish to and click the Select button.
[image: ]








The following pop up will appear but you don’t have to click anything.
[image: ]
Once it’s been successfully uploaded, you will received the ‘Success!’ message as shown below. Click the ‘Got it’ button to move to be able to log into Power BI online.

[image: ]















Open up an Internet browser and enter the following URL to log into Power BI Online:
https://powerbi.microsoft.com/en-us
Click the Sign in button
[image: ][image: ]

[image: ]Log in with your usual Power BI email and password you created earlier.
[image: ]
Navigate to ‘My workspace’ and you will see any current reports or dashboard you have that are active
[image: ]


On the Reports tab, you’ll notice the Primary – dashboard report we created earlier In Power Bi Desktop.
[image: ]

The dashboard layout we created in Power BI desktop will load up with all the visualisations.
[image: ]






You could try to Share the report but it will depend on your version of Power BI
[image: ]

If you’re on the free version, it will be restricted and give you the option of either trialling or upgrading your account.
[image: ]

If you do click the Upgrade account button, you will be presented with all the different options and pricing.

[image: ]



Publish to the Web
In order to upload to the web, select your report (under ‘My Workspace’) then go through the following routine:
File | Publish to Web

[image: ]

You will then receive the following message. Just click the ‘Create embed code’ button
[image: ]




Then click the Publish button
[image: ]

You will receive notification that the link has been established. Simply copy the URL before clicking the Close button
[image: ]

You can then paste the copied URL onto any Internet browser.
[image: ]






The familiar dashboard will now appear, the difference being that it can now be accessed anywhere in the world via the generated URL.
[image: ]

The filters on all the visualisations will work exactly the same as if you are using Power BI Desktop


[image: ]






Adding a Year Index for Sorting Years in Order

If your visualisations such as Stacked or clustered column charts don’t automatically arrange the Years in order of youngest to oldest, you may need to carry out some additional routines as follows:
On your Home tab, click the Enter Data button to allow us to create a new table:
[image: ]

You will then be able to enter data into a customised table. 
[image: ]






You can rename the column headings by clicking into the heading cell and overtyping Column1 with the word ‘Year’. Then click the Asterisk to create a second column.

[image: ]

Again, simply double click the cell and type over the word Column1 with the words ‘Year Index’
[image: ]


[image: ]








Once that’s done, enter in your respect school year groups, starting with the youngest on top and working down.
[image: ]

Once that’s done, in the Year Index column enter a numerical value in descending order. [image: ]









Also, ensure that you rename the table name to the word ‘YearIndex’. This will be used similar to a vlookup formula in Excel later on.
[image: ]

You notice now on the right side panel that the new table called YearIndex has been created.
[image: ]




The next step would then be to link the tables in the model section. 
[image: ]

Drag the year field from the YearIndex table and drag it onto the Pupil_Data table
[image: ]






Power BI will then create a line between the two tables (one-to-many), linking the Year field in both tables.
[image: ]

Back on the Data tab, click the ‘New Column’ button to add a new formula, also known as a DAX (Data Analysis Expression).
[image: ]

Type in the following syntax:
YearIndex = RELATED(YearIndex[Year Index])

[image: ][image: ]



The new column called YearIndex will have been created and will use a vlookup type algorithm to populate the column. However, you may have noticed that there aren’t any values for the Nursery pupils. 
[image: ]

The reason is because the field has by default been set as a numerical value, therefore N1, N2 and R aren’t recognised. Here’s the workaround:
Click the Edit Queries button and the Power Query Editor window will open up.

[image: ]







Here, you can change the type of field it is, i.e. from a numberical value to a Text based value:

[image: ]
















Right click the column, select Change Type and select Text as an option instead of Whole Number.
[image: ]

A pop up will appear. Just click the ‘Replace Current’ button:
[image: ]














The Years should now successfully pull through, simultaneously allowing us to create visualisations based on year progression.

[image: ]

Click the Save Icon.
[image: ]











Click Apply to apply any pending changes.
[image: ]

You will receive a message indicating that the change has been made.
[image: ]

Close the window
[image: ]

The Power Query Editor will prompt you to apply your changes. Select the Yes option, i.e. to immediately apply any changes.

[image: ]






The new column will now show the Years as a numerical value.

[image: ]
























The final thing to do is to change the ‘Sort by Column’ settings.
Select the Modelling Tab (horizontally) and the Data tab (vertically), select the Pupil Data tab and highlight the Year column so it’s selected. 

[image: ]

Then click the Sort by Column drop down
[image: ]












[image: ]



The default setting is Year (Default). However this needs to be changed to ‘YearIndex’












[image: ]


Select the YearIndex field.












		



Once that’s been done, any charts that you create using Year as your axis, it will automatically sort by youngest to oldest, i.e. N1, N2, R, 1, 2, 3, 4, 5, 6.
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Introduction

SIMS can hold a varying array of data, ranging from student attendance, assessment,
behaviour, achievement to staff absence and cover. Being able to extract this raw data to
represent itin a more meaningful and tangible way is more of a need now than ever. Unless
an individual s skilled in Excel formulas, pivot tables, macros, efc, it can be quite daunting to
meet the data needs of stakeholders in a school environment

Wha Microsoft Power BI and why is it useful?

Microsoft Power BI (MS PBI) is an analysis tool that allows you grasp a full overview of your
data in a meaningful way. Thus allowing you to represent data via dynamic, interactive
visualisations and dashboards with a few simple clicks.

This document will assist you in getting started from initially downloading the Power Bl app to
publishing and sharing your interactive visualisations

Power BI Desktop overview

The Power BI Desktop app allows you to import your SIMS data as a data source (for example
an Excel spreadsheet or -txt file). If you have imported two or more tables, you can then
manage relationships between the tables (e.g. one-to-one, one-fo-many, efc). You can then
create your reports, add filters and choose from a range of visualisations. You can save your
reports as Power Bl files (with an extension of .pbix) and you can publish the interactive
reports online for sharing.

Where can I download the Power BI Desktop app from?
"You can download the installation file for MS PBI via the following hyperlink:
https://powerbi.microsoft.com/en/downloads

What is the cost of using Power BI?

MS PBI Desktop is free and any single user and includes data cleansing and preparation,
custom visualisations and the ability to publish to the Power Bl service.

MS PBI Pro costs $9/99/£7 63 per month. However, if you have an Office 365 license, you will
be entitled to use MS PBI Pro with no additional charge.

The screenshot below from Microsoft highlights the differences

Which SIMS report can I use as a data source for Power BI?

We have created a SIMS report entitied ‘Power Bl — Basic Student Data’. This is a simple txt
file that can be used as a data source. The data fields used in the report for analysis purposes
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Itit also possible to have your ilters represents as a dropdown list, as opposed to a series
of checkboxes.

Hover over the top right PP fiter (over the dropdown arrow) and you will gt the following
popup:
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Dear Ahmed Yaseen,

Ihope you are well.
Iam contacting you from the Capita SIMS help desk in regards to the issue you have reported where a studentis showing on the schools Persistent
absence report but they are nota persistently absent student

Have you logged into the schools SIMS and actually checked the students attendance data to ensure the student is not persistently absent? The report
uses the same calculations for every student so it would either suggest they are persistently absent and the staff are reading the data wrong or the
student has had incorrect attendance marks entered in their registers.

Please check this with the school and let me know what you find.

Should you need any further assistance please let me know.
Kind Regards,

Richard Edwards
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